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If you accidentally quick twice on Slide 1, this will take you to the Slide View, again.  If this 

happens, simply click on the Slide Sorter View button at the bottom of the screen, just like you 

did on the last page. 

 

With Slide 1 “marked,” click the Animations Tab.  The Animations Ribbon will again open.   

 

 

For previous PowerPoint users, this is another “totally new” method.   
 

 

Notice in - the Animations Ribbon a Group – Transition to This Slide.   

 

 

Transitions are neat, visual actions, as we move from slide to 

slide in our show.  To get a “feel” for what Transitions do, 

click the More Arrow in the lower right corner of the 

Transition to This Slide Group. 

 

 

 

 

 

 

 

A Transition 

selection screen 

similar to the 

image on the right 

will appear. 

 

 

 

 

 

 

 

More Arrow 
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So, let’s get started in creating some movement (transitions) as we enhance our PowerPoint 

slide show.  Remember that we clicked-on Slide 1 to begin this process.   

We have enlarged the Fades and Dissolves and Wipes sections of the Transitions image on the 

last page.  We moved our cursor over Wipe Up and clicked on it.  Immediately our Slide 1 

Transitioned with a Wipe Up. 

 

 
 
At the bottom of  the Transition to This Slide Group there is a 

Random area.  One of the choices has a Question Mark ( ? ). 
We chose this selection and then chose Apply to All Slides.  So, 

when we show our slides, each slide will transition with a 

different effect. 
 

Go ahead and try as many Slide Transitions as you 

desire.  When you have one you like, look at the 

lower left corner of Slide 1.  You will see a small 
“shooting” star.  This means that a transition has 

been applied to this slide.  If you click the star, you 

will see the transition you selected will Play again.   
 
 
 
 
 
You can repeat the above process by clicking on 
each slide and selecting a different transition for 

each slide.  Or – Notice - on the right side of  the 

Transition to This Slide Group – you can select 

Apply to All.  And the transition you choose will be 

applied to all of your slides.  It’s up to you on how 

you want each slide to transition – or not transition. 

 
 

Also notice that there is a Transition Speed 
selection in this same area.  You may change your 

transition from Fast to Medium or Slow.   
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You may also add a Sound to your transition.  Click 

the small down arrow to the right of Transition Sound.  

A drop down list of sounds will appear.  We chose 

Chime for our Slide 1 Transition.   

 

Notice at the bottom of the “list” it indicates Other 

Sound….  When we found the bat sound on Microsoft 

Office Online, it placed the sound in our Clip Art 

Organizer.  To use this sound we had to choose Other 

Sound.  When we did, it was added to our list at the 

top. 

 

As you get more comfortable with sounds, you can find 

some really neat sounds all over the internet.   

 

 

 

 

Note:  many audiences do not like a lot of “sound” when watching a PowerPoint 
presentation.  So, you may desire to use sound “sparingly” in your presentation.   
 

Try it out! 
 

Go ahead and run/play your slide show again.  See how you like the transitions and sounds.  

Adjust as you desire. 

 

Don’t forget to save your work! 
 

 

Text Effects - Build: 

 

Building is a term indicating how each line of the text (on a slide) will enter the screen.  The 

lines, words, letters, pictures and charts can move in or appear from almost any direction.  To 

Build the text on each slide, follow these directions.  

 
 
Go back to Normal View.  You can do this in Slide Sorter View by double 
clicking quickly on the first slide or by Clicking on the Normal View 
button on the lower right corner of the screen.   
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Enhancing Text 
 

When the Slide 1 Normal View screen appears, click on the first line of text.  The first Text 

Box will appear as below. 

 

When you see the above Text Box, highlight the text.  When you do, you will again see the 

Drawing Tools Tab appear.  Click the Drawing Tools Tab and the Drawing Tools Ribbon will 

again appear – just like it did for WordArt. 

 

 

Please refer back to Pages 43 – 47 where we showed you how to use this Ribbon to 

enhance your WordArt.  To enhance your text you’ll do the same things you did with WordArt.  

So, click on the Shape Styles and WordArt Styles Groups and change your text as you desire.  

You can also use the Text Fill, Text Outline and Text Effects, just like you did before.  Be 

creative and give your text some zing.   

 

This is new in PowerPoint 2007 – using one Tab and Ribbon for both Text and WordArt! 

 
Animating Text 
 

This will be very similar to what we did on Page 50 with our Motion Path.   
 

Make sure your text is still highlighted. 

 

Click the Animations Tab again, then click 

the down triangle to the right of Custom 
Ani…. When the drop down menu appears 

click Custom Animation… (see images 

and arrows on the right). 
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The following Custom 

Animation Task Pane will 

appear on the right side of your 

screen (very similar to the one 

we used for Slide 9).  When this 

screen appears, first, click Add 

Effect   ( 1. ), then click 

Entrance         ( 2. ), and finally 

click More Effects ( 3. ) 
(because we want ALL of the 

effects). 

 

 

The Add Entrance Effect menu screen will 

appear (like the one on the left).   
 

Move your cursor over the blue Add 
Entrance Effect “bar” at the top of the 
menu screen.  Click and hold down the 
left mouse button and drag the menu 
screen to the right of your screen so that 

you can see the text in the Title text box.  

After you have moved this box raise your 

finger from the left mouse button. 

 

Choose one of the effects by clicking-on it.  
You will now be able to see the animation 
effect in the Text box.  You may hear a 

sound that is “part” of your Slide Transition.  

We’ll show you how to add sounds for your 

text in a moment. 

 

Try a lot of different effects.  Notice that 

there is an elevator bar on the right side of 

this menu.  As you move down the Add 
Entrance Effects menu screen you will 

notice that there are “groups” of effects – 

Basic, Subtle, Moderate, and Exciting.  

Try a “bunch” of these to see how they work.  

When you have an effect you like, click the 

OK button at the bottom of the Add 

Entrance Effect screen. 

2. 

3. 

1. 
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Now click-on the 

lower text box and 

repeat the steps we 
outlined on Pages 
59 and 60. 

 

 

 
Notice – on the right side of the screen - under 

Custom Animation – that the Titles (on which we 

added effects) are shown as a part of this screen (just 

like when we created our flying bat on Slide 9).   

 

Also notice, on the right side of our second title there 

is a small, down pointing arrow.  If you click-on this 

arrow it will show you each line of text that you 

animated in the lower sub-title box. 

 

Now we’ll enhance our text some more. 

 

 

 
Move your cursor over the first title and click the left mouse 

button.  Next click the small down arrow on the right side of 

this box.  You will see a menu screen appear that will let you 

enhance your title (just like you did in Slide 9).  Choose (click) 
Effect Options and the menu screen below will appear. 

 

 

 

 

This screen is similar to the one in 

Slide 9, but a little different.  

Notice that we chose Magnify for 

our text effect and then chose 
Laser for our sound.   

 

We’ll cover Dimming and All at 
once when we animate text in 
Slide 2. 

 

Go ahead and experiment with 
Entrance Effects and Sounds for 
your first Slide. 
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Entrance Effects and Sounds for Slide 2 
 

The question we receive the most is:  “How do you get the text to enter one letter at a time 
and have it sound like a typewriter is typing the text?” 

 

We’ll now show you how to do this. 

 

You should be on Slide 1 in the Normal View screen.  We need to 

move to Slide 2.  Look at left side of the Normal View screen.  You 

will see that this area looks like the image to the right.  Click-on 

Slide 2 in this area.  A orange border will go around the small slide 

and you will see Slide 2 in the center portion of your screen. 

 

 

 

 

You will see your bulleted list of 

ingredients in the large Slide 2 

area.  Move your cursor 

anywhere over the list and click 

on the list.   Your bulleted list 

should look like the image on the 

right. 

 

 

 

 
Click the Animations Tab again, then click 

the down triangle to the right of Custom 
Ani…. When the drop down menu appears 

click Custom Animation… (see images and 

arrows on the right). 
 

 

 

 

 

You will see the Custom Animation Task 

Pane  appear on the right (as you did in 

Slide 1).   

 
Select Add Effect, then Entrance and 

then More Effects (as you did in Slide 1). 
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This may not seem like much, but the choice 
of the Entrance Effect is very important 
here.  Notice, in the image to the right, that 

we chose Appear.  We need the text to 
enter, letter-by-letter, very quickly.  

Appear will take care of this.  Other choices 

may “look funny” when the animation is 

“running.”  When you become more 

accomplished with PowerPoint – try all 

kinds of effects.  Click the OK button when 

you have selected Appear. 

 

 

 

 

Look down the Custom Animation Task Pane on the 

right side of the screen until you see an area that looks 

like the image on the left.  Click the small down arrow 
on the right edge of the Content Placeholder and select 
Effect Options. 
 

 

 

 

 

When you click Effect 

Options an Appear menu 

screen (similar to the one on 

the right) will become 

visible.  We’ve gone ahead 

and entered the effects to 

make our text look and 

sound like an “old timey” 

typewriter typing. 

 

We clicked the down 
triangles to the right of 

each feature and did the 

following: 

 

 

 
Sound:  We clicked the down arrow to the right of Sound ( 1. ) and chose Typewriter. 

2 . 

1. 

3. 

4. 
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After animation (Dimming): 
 

We noticed that before we clicked the down arrow, that the words “Don’t Dim” appeared in the 

area to the right of After animation.  We then clicked on the down arrow and chose the light 

blue color that appeared ( 2. ).  When you are making your PowerPoint presentation, you might 

like to have the bullet, about which you are speaking, be more noticeable than the bullets about 

which you’ve already spoken.  By choosing the light blue color, as you move through the 

bulleted items, you will see the last bullet dim and the new bullet be more noticeable.  In a 

moment, when we complete this Appear Effect menu, we’ll Play our slide and you’ll see what 
we mean. 
 

Animate text: 
 

We clicked-on the down arrow and chose By letter ( 3. ). 
 

Seconds delay between letters 

 

We used the small “up and down” arrows to indicate 0.1 seconds between letters ( 4. ). 
When you “play” this slide you may desire to slow down or speed up the typing sound.  To do so 

simply repeat the above and vary the seconds. 

 

When you complete your Appear menu screen it should look like the one at the bottom of 
Page 63.  Click OK. 

 

 

Now, click-on Play at the bottom right of your screen.  

You will see the text enter like it’s being typed, hear the 

typewriter sound, and see the bullets dim as you proceed 

on to the next bullet. 

 

Sound 
 

Be Careful with Sound 
 

Be careful when using sound for transitions and text animation.  Sometimes, too many effects 

can overwhelm and detract from a presentation. As you become more experienced with sounds, 

and PowerPoint slides, you will find many web pages devoted to sounds and clip art.  In the 

Front Page tutorials, there is a section on WAV sounds.  If you desire a copy of any of these 

tutorials, simply e-mail the addresses at the end of this tutorial.  You may want to experiment 

with some other sounds you “download and save” form the internet. 

 

Don’t forget to keep saving your presentation as you enhance it with these 
effects. 
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Adding Color 
 
There are a several methods you can use to add color and other effects to your slides.  We’ll 

begin with Color Schemes and then move to Themes. 

 

Slide Color Schemes 
 

For those of you who have used PowerPoint Color Schemes in the past, 

Color Schemes takes on a whole new look in PowerPoint 2007.  You’ll 

be able to do all of the schemes you used previously - and a lot more. 

 

Click the small Slide 1 image on the left side of your screen. 

 

Next, click the Design Tab. 

 

 

The Slide Design Tab/Ribbon will appear.   

 

Notice the Themes Group takes up much of this ribbon.  

Once again, as you move your cursor over these 
Themes, you’ll notice that the Themes become visible 

on Slide 1. 

 

Since many PowerPoint users like Color Schemes, this is 

where we’ll to begin our slide coloring process.   

 

Look at the arrows on the right side of this page.  To 

color your slide, using a Color Scheme, you’ll need to 

click the small down arrow to the right of Colors. 

 

 

 

 

 

 

When you click Colors, the image above on the right will 

appear.  These are the default (Built-In) Color Schemes.  

You can choose them as you desire.  We’ll click the Create 
New Theme Colors selection at the bottom of this menu to 

create our own Color Scheme.   
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When you click Create New Theme 
Colors, the image on the right will appear.   

 

When you click the small down arrows to 

the right of several Theme colors 
selections, the Sample area, on the right 

side of this menu screen, changes with each 

selection. 

 

Below is an image of the Theme Colors 

drop down menu for Text/Background – 

Dark 1.  As you choose colors – you will 

see the result in the Sample area. 

 

 

 

 

When we finished our color selection, our 

Create New Them Colors selection, our 

Color Scheme looked like the one on the 

right. 

 

We named our new theme – Your New 

Theme Color.  You can name your Themes 

anything you desire.   

 

 

 

A huge CAUTION – but not 
a problem!  As soon as we clicked 

the Save button, our ENTIRE 
slide show changed to the new 
Color Scheme.    
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Our slides all changed to the new Color Scheme you see on the 

right.   

 

If you like the Color Scheme you created, this is 

not a problem.  If you do not like your scheme, 

you can click the Undo Arrow at the top of the 

screen.  When you click, your slide show will 

return to the slides you created previously.   

 

 

 

Notice that your new 
color scheme has been 

added to the Themes 
in the Design 
Tab/Ribbon.   
 

 

 

You have a lot of flexibility in 

PowerPoint 2007.  You can apply any 
of the Themes to specific slides, or to 

all slides.  When you RIGHT click 

on a theme, a pop-up menu will 
appear. You can choose to Apply to 
All Slides or to Apply to Selected 
Slides. 

 

 

 

 

We liked our new Color Scheme for Slide 1.  But, we wanted 

another theme for Slide 2.  We clicked on Slide 2. Then, we 

RIGHT clicked on one of the white themes and chose 
Apply to Selected Slides.  When we did, our Slide 2 changed 

to the white theme.  Our Slides 1 and 2 look like the image on 

the left. 

 

 

 
 
As you become more comfortable with PowerPoint 2007 you’ll be able to create Color Schemes 

and Themes that you can change, mix and apply to your slides.  So, experiment as you like.   
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Don’t forget to Save your work every now and then! 
 

Changing Colors in Color Schemes 
 

If you desire to change the colors in 

your Custom Color Scheme, click the 

down arrow to the right of Colors, and 

move your cursor over your Color 

Scheme and click the RIGHT mouse 

button.  An image similar to the one on 

the right will appear.  Move your cursor 
over Edit and click.  Your Create a 

New Theme Color menu (image in 

middle of Page 66) will appear.     
 

When your Create a New Theme Color menu appears, follow the instructions on Page 66 to 

make additional changes. 

 

Note of Caution:  Be very careful when you are working with background colors.  Many 

times color changes will make the text on the slide hard to read against a background.  All of 

the templates in PowerPoint are OK with color and text, but when you start changing either the 

background or text color, you may create a slide where the text is hard to see.  So, again be 

careful – and remember the Undo Arrow. 

 

Backgrounds 
 

 
 
Click Slide 2.   

 

 

 

We’ll use some other 

features in PowerPoint 

2007 to enhance the 

backgrounds of our 

slides. 

 

 

On the right side of the Design Tab/Ribbon you’ll 

see a Background Styles choice.  Click the down 
arrow to the right of Background Styles.  The 

menu screen on the right will appear.   
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Click the Format Background selection. 

 

 

The Format Background menu screen on the right 

will appear.  Notice that there are several choices:  

Solid fill, Gradient fill, and Picture or texture fill.  
We’ll now look at each of these. 

 

Gradient 
 
When you click the small circle to the left of 

Gradient fill, the image below will appear. 

 

 
As soon as you click Gradient fill, you’ll 

notice your Slide 2 changes to the default 
Gradient fill (you see on the left image.) 

 

Notice all of the choices.  First, we’ll click 
Preset colors.   

 
 
When we click the down arrow to the right of 

Preset colors the image on the right appears.  

Move your cursor over one of the selections and 

click on it.  Slide 2 will change to this Gradient.  

Click a couple of other choices.   

 

When you have the “feel” for Preset colors, click 

on several of the other choices below Preset colors 

and try them.  Needless to say, you can spend a lot 

of time enhancing your slides with this feature. 
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When you finish, if you don’t like your choices, use the Undo Arrow.   

 
 
Picture or texture fill 
 

Next we’ll enhance our Slide 2 with Pictures and Textures.  We’ll start with Textures.  Click the 

small circle to the left of Picture or texture fill. 
 

 
 

As soon as you click the circle, your Slide 2 will look similar to 
the image above.  It has taken the look of the first Texture choice.  

To “see” this, click the down arrow to the right of Texture and your 

screen will look like the image above.  Click several of the Textures 

in the selection area. 
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Picture 
 

Now we’ll work with adding Pictures to the 

background of Slide 2.  Look at the Fill 
menu again and notice that when you 

clicked on Picture or texture fill that an 

Insert from:  set of buttons appeared.  

This indicates that you can insert you picture 

from a file on your computer, your 

Clipboard or from Clip Art.  

  

 

In the image below we clicked the Clip Art button.  When we clicked, the Select Picture 
menu screen appeared.  The images showing in the Clip Art menu screen are images that we 
have used recently.  We chose the stack of books and clicked the OK button.  Our Slide 2 now 

looks like the image to the left.   
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You experiment as you desire with the various Backgrounds.  Don’t forget the 

Undo Arrow if you need to try other effects. 

 

Themes 
 

Finally, we’ll apply Themes to our slides.    

 

For those who are familiar with previous versions of PowerPoint, Themes are similar to the 

Design Templates.  For those using PowerPoint for the first time we’ll show you how to use 

Design Templates on individual slides, or on all of the slides in your presentation.  If you are not 

on the Design Tab/Ribbon, click the Design Tab.  You will see the Themes Group. 

 

 

 

 

 

We “cleared” our Slide 2 (using the Undo Arrow) so that 

the Slide 2, on the left of our screen, looks like the image on 

the right. 

 

 

 

 

 

 

 

 

 

 

 

Once again, as we 

move our cursor 

over a Theme, we 

see that Slide 2 

reflects our 

choice. 
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To view additional Themes, click the More arrow 

in the lower right corner of the Themes Group. 
 
 
 
 
As you 

move your 

cursor over 

these 

additional 

Themes, 

you will 

see the 

Theme 

appear in 

Slide 2. 

 

 

 

 
 

 

If you click a Theme, 

PowerPoint will assume you 

desire to select this Theme 

for ALL the slides in your 

presentation.  We clicked on 

the Verve Theme you see on 

the left. 

 
 
As you can see (in the image on the right) all of the slides were 
changed to the Verve theme  – except Slide 1.  Since we 

indicated that Slide 1 should use a Color Scheme, it remained 

unchanged. 

 

 

 

 

 

More Arrow 
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If this is not what you desire, click the Undo Arrow and begin again.      

 

 

 

 

 

If want a different Theme for different 

slides, click on a slide, then move your 
cursor over the theme you desire and click 

the RIGHT mouse button.  The pop-up 
menu on the left will appear.  Choose Apply 
to Selected Slides. 

 

 

 
 
 
 
We clicked Slide 2 and followed the instructions above.  Our 

Slide 2 now looks like the image on the right.  Notice that Slide 3 

remains the same.   

 

Many PowerPoint users desire to have a single theme or color 

scheme for their presentations.   

 

It might be wise to check with folks who know your audience 

before you create a lot of different slides with animations and 

sounds to make sure you know what they desire. 

 
 
 
 
 

 

You can choose the view you like best when you are applying Color Schemes and Themes.   We 

used the Normal View above.  Many users like to use the Slide Sorter View as they select their 

choices – so they can see all of their slides. 

 

 

 

 

To change your view to Slide 
Sorter View (like we did no Page 8), 

look at the lower right corner of 

Slide Sorter View 
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your screen and click on the Slide Sorter button.   
 

 

When we clicked the Slide Sorter View button, our screen looked like the image below. 

 

 

 

 

We decided to have the same Theme for all of our slides, so we chose one we liked.  Our Slide 

Sorter View now looks like the image below.  

 

 

 
 

You choose a Color Scheme, Theme or combination that you like for your slides. 

Notice that when the Theme was applied that, in addition to the background changing, the text, 
formatting, and colors of some of your objects also changed.  In a minute we’ll view our 

entire slide show again.  As you go through your show, you might want to make a note of 
color changes that do not enhance your presentation.  Most notably, when you choose 

Dimming for text, the Dimming often is more noticeable than the text.  So, you might want to 

change your dimming color to work with your slide show. 
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Run the show: 

 

Now you have a real presentation!  Make sure you are on Slide # 1.  Go to Slide # 1 either 
in Slide Sorter View or Normal View.   
 

 

 

To view your show, you can click the View 

Tab and then click the Slide Show button. 
 
 

 

 

 

 

 

 

 

Or, you can just click on the Slide Show button 

at the bottom of the screen (on the lower right).   
 

 

 

 

 

To advance (go forward to the next slide or have text or graphics enter), you can tap the left 
mouse button, Space Bar, Right Arrow key or Enter key. If you want to “go back” to a 

previous slide (or effect), tap either the back arrow key or the Backspace key on the keyboard.  

You can also click the RIGHT mouse button at any time and a menu will appear that will 

assist you to move between the slides.   

 

If you desire to end the show, either tap the Esc key, in the upper left portion of the keyboard, 

or click the right mouse button and then click End Show.   
 
 

Practice moving through your slide show a number of times to get the “feel” 
of how PowerPoint 2007 works. 
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If you created set times on the Animations Tab for your 

slides (Pages 55-58), and desire to have the show run in 

“automatic,” click the Slide Show Tab and then click the 
Set Up Slide Show button.  
 
 
 
 

 

 

The following Set Up Show menu screen will appear. 

 

 
In the Advance slides box (image above), click the circular area to the left of Using timings, if 
present.  Look over the other choices in this menu screen.  Notice that there are a lot of 

enhancements in this Set Up Show menu screen.  Experiment, as you desire.  You can always 
come back and change them.  Click the OK button when you have made your changes.  One 
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thing people find most helpful, if they desire to have the show repeat continuously, is the 

Loop continuously until ‘Esc’ selection.  This is indicated by an arrow to the Show options 

area. 

 

To really get precise timing for each slide transition, 

sound, and build, you can use a feature to set each 
movement precisely.  Click on Slide Show Tab and 

then select Rehearse Timings.   

 

 

A small, 
rehearse 
timings “box” 
will appear  

(image above).  It will “show” a running clock on the 

right side of the menu – that indicates the time for the 
entire show.  In the center you will see another time 

for each “click” – transition, build, etc.  When you 
click through your show, as indicated above, the 

timings will be recorded. When you click the “last 

time” and the slide show transitions to the black screen, you will see a Microsoft Office 
PowerPoint menu screen similar to the one below.   

 

You can choose Yes or No.  When you then run the show, it will run at the recorded pace. 

You can do this as often as you like, and change the timing anytime you desire. 

 

 

 

 

Save your presentation.    

 

When you have saved your presentation – click the Microsoft 
Office button in the upper left corner of your screen and  Exit 
Power Point. 

 

These are the basics for a PowerPoint 2007 presentation.   

 

To open your PowerPoint 
presentation again, open Power Point 

(Page 1) and click the Microsoft 
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Office Button.  Click on your presentation in Recent Documents.   

A nice feature – saving to a CD 
 

 

 

A really nice feature in PowerPoint 2007 

is the ability to save your PowerPoint 

2007 presentation to a CD and take it 
anywhere.  And when you take the 

presentation with you,  you won’t need 
PowerPoint 2007 to show the 
presentation!  When the CD is created it 

includes a PowerPoint viewer that will 

show your CD, regardless of the computer 

you are using!   

 

To use this feature, click the Microsoft 
Office button and move your cursor 
over Publish.   On the right side of the 

menu screen click Package for CD (see 

image and arrows on the right). 
 

 

The Package for CD menu screen will 

appear (like the image on the left).  
Package for a CD will create a folder 

either on your computer or copy the 

folder directly to a CD (if your CD 

creation program allows for this). 

 

The first thing we have to do is create a 
name for our folder and type-it in the 
Name the CD: area on the Package CD 

menu. 

 

We chose “PBJ 2007 Present” (as seen in the image above).  Next, we decided to save this 

folder to our C: drive.  Last, we chose Copy to Folder… in the menu screen.  When we clicked 

on Copy to Folder… the Copy to Folder menu screen appeared (like the image below).   

 

The name of our Folder is shown in the 

Folder name: area (created in the previous 

menu screen).  We chose to save the Folder 

to our C: hard disk drive, so we typed 
C:\ in the Location: area (as seen at the 



 80 

right).  You can also choose the Browse button so that you can “browse” to any drive on your 

computer to save the Folder.          When you have made your selections, click OK. 

After you click OK, your computer will “run” for a few minutes and then return to the Package 
for CD menu screen on the last page.  When this occurs, simply click the Close button and the 

menu screen will go away. 

 

You may see the Microsoft Office PowerPoint screen below.  If you do, click the Yes button. 

 

 

If you then go to the drive on which you saved your folder, you 

will see a folder icon similar to the one on the right.  You can 

either double-click quickly on the folder to open it, or you can 

right click on the folder and select Open. 

 

When your folder opens, you are able to see the files created by PowerPoint Package a CD, they 

will look something like the image below.  If you go to another computer that has 
PowerPoint 2007, the How to make a Great PBJ.ppt file is available for you.  If the 
computer does not have PowerPoint 2007, you can use the PPTVIEW.EXE file to show 
your presentation (see arrows below).   
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2007 Video Tutorials 
 

Microsoft PowerPoint 2007  

Starting PowerPoint 

Ribbon Overview 

Adding Text to Title Slide 

Design Options 

Saving the Presentation 

Adding Slides 

Adding Text and Undo 

Slide Layout 

Adding a Picture 

Adding Clip Art 

Adding a Table 

Changing Text Alignment 

Adding SmartArt Graphics 

Adding WordArt 

Adding Transitions 

Adding Animations 

Inserting Sounds 

Inserting Movies 

Viewing the Presentation 

 

videos\StartingPowerPoint.swf
videos\RibbonOverview.swf
videos\AddingTexttoTitleSlide.swf
videos\DesignOptions.swf
videos\SaveYourPresentation.swf
videos\AddaSlide.swf
videos\Addtextandundo.swf
videos\SlideLayout.swf
videos\AddingaPicture2.swf
videos\AddingClipArt1.swf
videos\AddingaTable.swf
videos\Celltextchanges.swf
videos\SmartArtGraphics.swf
videos\WordArt.swf
videos\Transitions.swf
videos\Animations.swf
videos\InsertSounds.swf
videos\InsertMovie.swf
videos\RunthePresentation.swf



